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Introduction 
Welcome to Colligo Contributor Client, the program helps extend the power of SharePoint to mobile and 
remote workers. Instantly and securely access, modify, and create SharePoint documents, list items, and 
metadata while offline. Sync changes to libraries and lists automatically when connected. Keep team 
members productive, regardless of network latency or unavailability, in the field or on the road. 

Benefits 
Colligo Contributor Client helps: 

 Empower users to easily manage email and documents in SharePoint 

 Increase the quantity of content captured and tagged in SharePoint 

 Make SharePoint accessible directly from the desktop 

 Drive mobile and remote workforce productivity with easy offline access 

 Improve collaboration, and document project management 

 Improve records retention to reduce risk and improve compliance 

Features 
Colligo Contributor Client lets you: 

 Drag-and-drop documents to SharePoint 

 Navigate to cached SharePoint content 

 Sync documents, document sets, libraries, or entire SharePoint sites 

 Open, save, organize, and classify SharePoint files directly from Windows Explorer 

Platforms Supported 
 Microsoft SharePoint Server 2010, MOSS 2007, SharePoint Portal Server (SPS) 2003 

 SharePoint Foundation Microsoft Windows SharePoint Services (WSS) 3.0, or 2.0 

 SharePoint 2010 Online (Office365) 

 SharePoint 2013  

 Outlook 2007, 2010, 2013 Preview (32-bit and 64-bit) 

 Windows XP Professional, Windows Vista, Windows 7, Windows 8 
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Installing and Activating Contributor Client 
To install and activate Contributor Client: 
1. Double-click to open the zip file and extract the contents.  
2. In the folder, double-click the folder that corresponds to your operating system:  

a) x64: choose this option if you have a 64-bit operating system 
b) x86: choose this option if you have a 32-bit operating system 

3. Double-click either Setup.exe or .msi. 
4. Follow the steps in the install wizard.  
5. After the install is complete, the following dialog displays:  

 

6. Enter your information and click Activate. If you do not activate Contributor Client, it will not launch.  
7. After you have installed Contributor Client, choose Colligo Contributor from your Start menu or 

from the system tray icon to launch the interface: 

 

 

The Document Libraries and Lists display in the left column, and the content of the selected list or 
library displays in the right section. 



  Colligo Contributor Client 

12/02/2013 Copyright 2013 Colligo Networks, Inc.  All rights reserved. 
Not to be reproduced without permission. Learn more at www.colligo.com. 

Page 4 of 24 

 

 

Activating Contributor Client Manually  
If you are unable to connect to the activation server, the following error message displays:  

 

Click Activate via Email to create an activation request file. The following dialog displays: 

 

Click Export Activation Request. This creates a .txt file that you can save anywhere on your machine, 
and then attach to an email that you can send to Colligo to request a manual activation.  
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Checking for Updates 
In the Contributor Client Control Panel, you can check if you are using the most current version of the 
program: 
1. From the Help menu, select Check for Update. The www.colligo.com site launches. 
2. If there is a newer version available, click the Download the latest version now link to install the 

newer build.  

Updating Your License Key 
In the Contributor Client Control Panel, you can change your license key: 
1. From the Help menu, select Install License Key.  
2. The Enter License Key dialog displays. Enter your new license key and click OK.  

 

  

http://www.colligo.com/
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Connecting SharePoint Sites 
You can add a SharePoint list or library to Contributor Client in one of two ways: 
 Using the Connect to Contributor option in Internet Explorer 
 Using the Download New Site option 

Using the Connect to Contributor Button 
1. Navigate to a SharePoint List or Library in Internet Explorer. 
2. Click the green Connect to Contributor icon on the toolbar. 

 

3. The Download New Site dialog displays. Select either your default Windows credentials, or supply 
other user-specific credentials. 

 

4. Click Download. 
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The Select for Synchronization dialog displays the lists and libraries you have permissions for: 

 

5. Check the boxes beside the lists and libraries you want to synchronize; use the Check All or Uncheck 
All buttons if needed. 

6. Click Filter to select which folders and views you want to synchronize. 
The Select Filters for Synchronization dialog displays: 
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7. Choose from the following options: 

 Disable Synchronization for this Document Library: choose this option if you do not want 
the document library to be available offline.  

 Synchronize Entire Document Library: choose this option if want to synchronize everything 
in the specified document library.  

 Only synchronize content based on the following filters: choose this option if you want to 
selectively choose what folders and views are synchronized. In the Synchronized Folders 
and Synchronized Views sections, select a folder or view you want to synchronize and click 
Add to move it to the Selected Folders/Views column.  

8. Click OK.  
9. Click Synchronize to download the information for the lists and libraries you have selected. 
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Using the Download New Site Option 
To connect a site from within Colligo Contributor Client:  
1. From the Site menu, choose Download New Site:  

  

The Download New Site dialog displays: 

 

2. Enter the URL of the site and enter your default credentials, or user-specific credentials.  
3. See steps 6 to 9 of Using the Connect to Contributor Button.  
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Editing Lists and Libraries  
After you have added your site and chosen which lists and libraries you want to sync, you may want to 
go back at a later time and edit your choices. You can do this in one of two ways: 

1. Right-click a list or library and select Enable Synchronization from the contextual menu. Then 
synchronize the site.  

OR 

1. From the Site menu, choose Download New Site.  
The Download New Site dialog displays: 

 

2. From the Site drop-down list, choose which site you want to configure.  
The Synchronize Site dialog displays: 

 

3. Click Configure.  
4. In the Configure Synchronization dialog, choose which Lists and Libraries you want to sync. 
5. Click OK. 
6. Synchronize the new site.  
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Setting Synchronization Options 
In Contributor Client you can set your Synchronization options to your lists and libraries sync 
automatically. However, you can also perform manual syncs as well.  

Configuring Synchronization Settings 
1. From the View menu, select Options.  

The Colligo Contributor Options dialog displays: 

 

2. In the General section, you can turn on the prompt to record properties about the document by 
checking the Prompt for properties when adding documents box. You can override this setting for 
specific lists/libraries when you are configuring Default Metadata; see Setting Default Metadata.  

3. In the Synchronization section, choose your preferred options: 
4. In the Synchronization section, choose your preferred options: 

a. Synchronize on startup: choose this option if you want your lists and libraries to synchronize 
every time Contributor Client starts  

b. Synchronize when list is viewed: choose this option if you want your lists and libraries to 
synchronize every time you view a list or library  

c. Synchronize when list is modified: choose this option if you want your lists and libraries to 
synchronize every time you modify a list or library  

d. Enable combined check-in and sync: choose this option if you want to combine the step of 
checking in a document and simultaneously syncing it  

e. Enable background synchronization: choose this option if you want to set the 
synchronization to happen in the background on a time-specific basis, and enter your 
preferred time interval 

f. Automatically download lists to resolve Site Column values: if you have lists that reference 
other lists (look-ups), checking this option ensures the related referenced lists are also 
downloaded 

NOTE: Depending on how your IT Administrator has configured the installation, this dialog may not be 
accessible to you, or the synchronization options may be greyed out. 
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Synchronizing Sites Manually 
After you have added your sites, you may want to synchronize them manually, outside of the settings 
you set in the Colligo Contributor Options dialog: 

1. Click the Synchronize menu to display the options: 

 

Choose from the following: 

 Synchronize Site: select this option to synchronize the site currently displayed 

 Synchronize Multiple Sites: select this option to display all sites and choose which ones you 
want to synchronize 

 Synchronize All: select this option to synchronize all sites 

 Synchronize Pending Changes: select this option to synchronize any lists or libraries containing 
changed content 

The Synchronization In Progress dialog displays for any of the above options: 

 

Completing a Full Synchronization 
Several of the synchronization dialogs have a Perform Full Synchronization option. This option means 
that additional information is downloaded, including definitions for Sites, Lists, Views, and Content 
Types, plus other site content that may not be retrieved during other standard sync processes. 
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Viewing and Synchronizing Pending Changes  
You can review content that has changed since the last synchronization and then synchronize it: 
1. From the View menu, select View Pending Changes. 

The Pending Synchronization Changes dialog displays: 

 

2. To discard the changes for a particular item, right-click it and choose Discard Changes. Discarded 
changes are reverted upon the next synchronization. 

3. Click Synchronize. 
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Viewing, Editing, and Creating Content 
After you have added and synchronized your lists and libraries, the content is cached (available offline). 
You can open, edit, rename, and delete SharePoint items, and check items in and out of SharePoint. 

The Tree View in Contributor Client allows you to view content more dynamically and to move and copy 
content between folders in the same SharePoint site using drag-and-drop. You can change the view by 
enabling or disabling the Tree View option in the View menu:  

 

NOTE: you cannot enable or disable synchronization of document libraries or lists while Tree View is 
enabled. If you want to do this, you must turn off Tree View and work in List View.  

NOTE: If the Tree View option is not available to you, it has been disabled by your IT Administrator.  

Viewing Content 
After you have added and synchronized your sites, the libraries you have chosen to sync display in the 
left pane under the Site Collection heading; the contents of a selected library display in the right pane: 
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If Tree View is enabled, you can expand and contract folders in the left pane to navigate to the 
SharePoint location you are looking for. The folder that is highlighted in the Tree View indicates the 
SharePoint location you are currently are viewing.  

 

To view an item, double-click it to launch it in the item’s native program. If the item is checked out by 
another user, it opens in Read-Only mode.  
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Editing Content 
To edit an item, double-click it to open it in the item’s native program. You can then edit the item as 
preferred, save it, and close it.  

The changes are uploaded to SharePoint the next time the list/library is synchronized.  

NOTE: you cannot edit an item if it is checked out by another user. If the item is checked out, a red 
arrow icon displays on the item: 

 

Resolving Editing Conflicts 
If another user has opened the document, edited it, and uploaded it to SharePoint, and you try to 
upload the same document with your changes, the following dialog displays: 

 

You can click Open to view the edits in each version, and then click one of the following options: 

 Choose Local Version: if you choose this option, the version on your local machine overwrites 
the current version on SharePoint 

 Merge Versions: If you choose this option, a wizard displays and walks you through a process to 
choose the changes you want to keep or discard  

 Choose Server Version: if you choose this option, the version on SharePoint does not change; 
you are effectively discarding your version 
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Editing Item Properties 
To edit the properties of an item, right-click it and choose Edit Properties: 

 

The Edit Properties dialog displays. Edit as preferred and click Close.  

The changes are uploaded to SharePoint the next time the list/library is synchronized.  

NOTE: you cannot edit an item’s properties if it is checked out by another user. If the item is checked 
out, a red Check Out icon displays on the item. 
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Checking Items In or Out 
To check an item in or out, right-click it and choose Check Out/In. The Check In option only displays if 
you have previously checked the item out. 

 

Once you have checked an item out, the Check Out icon is overlaid on top of the document type icon, so 

users can see that the item is being edited:  

After you have checked the item out, you can open it, edit it, and then check it back in to the list/library. 
The changes are uploaded to SharePoint the next time the list/library is synchronized.  

NOTE: If you try to check out an item that has been modified in SharePoint and not synchronized, the 
following message displays:  

 

You need to close the dialog, synchronize the site so you have the most up-to-date version of the 
document, and then perform the Check Out operation again.  

To avoid the above conflict, select the combined check-in and sync option as described in Setting 
Synchronization Options.  
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Renaming Items 
To rename an item, right-click it and select Rename.  

 

The item name becomes editable. Edit as preferred, and press Enter to complete the change.  

The change is reflected in SharePoint the next time the list/library is synchronized.  

NOTE: you cannot rename an item if it is checked out by another user. If the item is checked out, a red 
Check Out icon displays on the item. 

Deleting Items  
To delete an item, right-click it and select Delete.  

The change is reflected in SharePoint the next time the list/library is synchronized. 

NOTE: you cannot delete an item if it is checked out by another user. If the item is checked out, a red 
check-out icon displays on the item. 
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Creating New Content 
In addition to editing existing content in SharePoint, you can also add new content to your synchronized 
lists and libraries. 

You can add items to Contributor Client in one of the following ways: 

 Create new documents from within the Contributor Client interface 

 Upload existing content 

 Drag-and-drop or copy-and-paste content 

When you are adding content from your Windows desktop or directory to SharePoint using the Client 
interface, the content is always copied to SharePoint. When you are moving content from one 
SharePoint location to another within the Client interface you have the option to move or copy the 
content; see Moving or Copying Content within SharePoint.  

Adding a New Document to a List/Library 
To add a new document to a list or library: 
1. With the list or library you want to add the document to selected, click the New menu and select 

your preferred document type from the drop-down list:  
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The Create New Document dialog displays: 

 

2. Choose your document type from the Site Templates tab or the Other tab. 
3. Enter a name for the document, and click Create.  

The New Item dialog displays. This is where you can record information about the document that is 
stored in SharePoint as well as choose the location of the document (click Folder to browse the 
folders and subfolders in the list or library).  

4. Edit the New Item dialog as preferred.  

 

5. Click Create. The document is added to the SharePoint location. 
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Using the Upload Documents Dialog 
To add an existing document to a list or library: 
1. With the list or library you want to add the document to selected, click the Upload menu, and 

choose Upload Documents: 

 

The Upload Documents dialog displays.  
2. Browse to the document that you want to upload, and click Open. To select more than one 

document, use Ctrl + click.  
3. The New Item dialog displays. Edit as preferred and click Create. 

The document is added to the SharePoint location. If you have selected more than one document, 
any properties you assign apply to all items.  

Dragging-and-Dropping Content 
You can drag-and-drop one or more files or complete folder structures into Contributor Client from your 
Windows desktop or from other directory locations.  

1. Drag-and-drop your preferred files or folders from your desktop or another directory to your 
preferred SharePoint location in Contributor Client.  

2. The New Item dialog displays. Edit as preferred and click Create. The file or folder is added to the 
SharePoint location. If you have selected more than one document or a folder, any properties you 
assign apply to all items.  
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Moving or Copying Content within SharePoint 
You can move or copy content from one location in SharePoint to another location, through the 
Contributor Client interface.  

NOTE: this feature is disabled by default. Contact your IT Administrator. 

1. Select one or more files in a library or folder, and drag-and-drop it to another folder. 
The New Item dialog displays.  

2. Edit as preferred and click Create. 
The following dialog displays:  

 

3. Click Move or Copy. Note that no version history, timestamps, or original author information is 
preserved in either the Move or Copy action. If you choose to move an item, the original file is 
deleted. In addition, any metadata associated with the original file will not be preserved and you will 
need to enter new metadata for the item. 

NOTE: You cannot move an item that is checked out by another user. If you attempt to do this, the 
following error message displays: 

 

If you hover your mouse over the item, a message displays telling you who has the item checked 
out. That user needs to check the item back in before you can move the item.  
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Setting Default Metadata 
If you want to tag all documents and items that you add or upload to a list or library with the same 
metadata, you can set default metadata values through the Contributor Client interface: 

1. From the Control Panel File menu, choose Default Metadata Values.  
The Default Metadata Values dialog displays:  

 

2. Select the site and library/list that you want to configure.  
3. To add a metadata tag, click Add.  

The Add Default Meta data Properties dialog displays, displaying the metadata field options that 
are set in the document library in SharePoint.  

 

4. Enter your preferred tags and click Add.  
5. If you want the values to propagate to any subfolders, check the Propagate these default metadata 

values to subfolders box.  
6. To configure the behavior or the prompt to record document properties, choose a radio button on 

the right under the When adding documents, prompt for properties section: 

 Always 

 Never 

 According to application global settings (as set in step 2 in Configuring Synchronization 
Settings) 


